AR-837-E/EE/EF/ER/W

V220811

AR-837-EF:Fingerprint

@ Products @ Terminal Cables ©® Tools © Optional
o Ethernet: DMOD-NETMA10
mmm Screws . % (TCP/IP Module included RJ45 Connector)
CN4 ® or
| L DMOD-NETMA11
- (TCP/IP Module with POE function)
oo Water proof Strip » Any Wiegand Output Module (CN10)
3DO ® AR-MDL-721V (Voice Module)
| Em | © AR-321L485-5V (TTL to RS-485 Converter)
AR-837-E/ EE / ER:LCD Access Controller
@ Products @ Terminal Cables ©® Tools @ Optional
Screws @ AR-837-E/ER ¢ Ethernet: DMOD-NETMA10
--------------------------------- (TCP/IP Module included RJ45 Connector)
Jll CN5 Screws %9 837-EE or
L / @ DMOD-NETMA11

(TCP/IP Module with POE function)
Water proof Strip /™~ AR-837-E/EE e Any Wiegand Output Module (CN10)
o T ® AR-MDL-721V (Voice Module)
® AR-321L485-5V (TTL to RS-485 Converter)

837-E 837-EE 837-ER

Water proof Strip 837-ER

Tailel
AR-837-W:LCD Card Energy Saver

@ Products @ Terminal Cables @ Optional

o Ethernet :

©® Tools

DMOD-NETMA10
(TCP/IP Module included RJ45 Connector)

or

DMOD-NETMA11
(TCP/IP Module with POE function)

o Any Wiegand Output Module (CN10)

=1
NIl g
Water proof Strip
® AR-MDL-721V (Voice Module)

%% l N o AR-321L485-5V (TTL to RS-485 Converter)
Installation (AR-837-E/EE/EF/W)

© A-1.Surface Mounted: Use a screwdriver to screw the mounting plate
to the wall. A-2.Embedded: To dig a hole for 837-E:85mmx113mm /
837-EF:128mmx109mm; and then, use a screwdriver to screw the
mounting plate to the wall.

® Pull cable ends through the access hole in the mounting plate.

® Attach AR-837-E or AR-837-EF to the mounting plate and install
screws (supplied) into the holes at the bottom with the allen key.

o Apply power. LED (green) will light up with one beep.

@@

Screws
CN5

A-2.Embedded B.

A-1.Surface
Mounted

INSTALLATION

» Surface mounting hole(Front View)
¢ Flush mounting hole(Front View)
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ACCESS & INDUSTRIAL CONTROL
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» Surface mounting hole(Front View)

» Surface mounting hole
 Flush mounting hole(Front View)

* Flush mounting hole
(Side view)

(Side view)

AR-837-ER el

108 mm 30 mm
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» Surface mounting hole(Front View) » Surface mounting hole

(Side view)

1.Tubing: The communication wires and power line should NOT be bound in the same conduit or tubing.
2.Wire selection: Use AWG 22-24 Shielded Twist Pair to avoid star wiring, CAT 5 cable for TCP/IP connection

3.Power supply: Don’t equip reader and lock with the same power supply. The power for reader may be unstable when the lock is activating, that may cause a
malfunction in the reader.

The standard installation: Door relay and lock use the same power supply, and reader should use another independent power supply.

Connector Table (1)

A
Cable: - e gen 3
Wire Application  |Wire Color Description E -
Anti-Tamper Switch | 1 Red N.C. by } 2
2 Orange |COM .%. 6
3 Yellow  |N.O. |4 5
Cable: E CNs | py g
Wire Application | Wire Color Description 2 [1]
Lock Relay 1 Blue White |(N.O.)DC24V1Amp I
2 | Purple White |(N.C.)DC24V1Amp EEEEEa
Lock Relay COM 3 White (COM)DC24V1Amp
Door Sensor 4 Orange |Negative Trigger Input Cable: &~ 28] ¥
Exit Switch 5 Purple  |Negative Trigger Input Wire Application | Wire Color |Description
Alarm Relay 6 Gray N.O./N.C. Optional (by jumper) : 1 | ThokG RS.485(B
Power 7 | ThickRed |DC 12V RS-485 for Lift ick Green |RS-485(B-)
8 | ThickBlack |DC OV Controller 2 | Thick Blue |RS-485(A+)




LCD / Biometrics Access Controller

| LCD Card Energy Saver
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Connector Table (1)

Cable:

Wire Application
Beeper

LED

Door Output

Wiegand

WG Door Sensor
WG Exit Switch

Cable:

TCP/IP Output

Wire

Wire Application | Wire

1

N WON

1
2

3

4

5
6
7
8

Color Description
Pink Beeper Output 5V/100mA, Low
Yellow Red LED Output 5V/20mA, Max
Brown Green LED Output 5V/20mA, Max
Thin Green |Wiegand DAT: 0 Input
ThinBlue |Wiegand DAT: 1 Input
Orange |Negative Trigger Input
Purple Negative Trigger Input

Color

Orange White
Orange
Green White
Gem

Connector Table (2): Optional

Cable:

Description | |Wire Application
- \oice Module

- (*Required speaker
| B/ 1.5W (Vax
Net - RX+ 20)

Net - RX-

\O’U‘IA@I\)
Q
)
3
Q
[

Wire| Color

1 Black

DC oV

Cable:

Wire Application
Reserved
Security trigger signal
Arming

Duress

Cable: [o\'kK]

Wire Application |Wire

Door Bell

Cable: [4 K[V

Description | |Wire Application \Wire, Color
HID RF Module 1

X
TE

Wire Color Description
1 Red -
2 Purple Security trigger signal Output

3 Red White |Arming Output
4 | Yellow White |Duress Output

Color | Description
.| Transistor Output Max. 12V/100mA
1| Black White (Open Collector Active Low)
2 Black |DC 0V

Description |
ANT 1

ANT 2

DC 0V

DC 5V

Wiegand DAT: 1 Input
Wiegand DAT: O Input

Orange
Purple
Black

Red
Blue

Green

White

Wiring Diagram
Connect to Electric Bolt :

-

L

Controller

( . \
Main Port

N.O.

}l@| RTE

GND

N—1—
12v
GND | /\'

E
RN P.T.Exit
N.C.

AR-1207

Door Sensor |
AR-MS-101-A |

+|POWER
—| 12VDC

Door Open Too Long Alarm Wiring
Method (External Door Sensor)

JLL

Magnetic
Lock

POWER
-/ 12vDC

Tamper-Switch Alarm Wiring Method

(Connect to Central Monitoring System through Modbus

via Universal I/O Module)

N.C. <.
Controller 0. <
(] \ i Electric Bolt
CN5 Main Port o ec
o = AR-1207
Door Sensor Port W _
AR-MS-101-A N.C.NN | POWER
Com| 3 =M -] 12vDC
Door Sensor| 4
@ Buzzer
o - | AMEN—T— { - | 12VvDC
Buzzer 12vid —
12VvDC -~ GNDIf ] POWER
! 1—] 12vDC
30 |
Built-i
+| POWER L Tamper Switch/ mﬂi SCADA
—| 12VvDC O— GND |

Universal /0 Module

AR-403-

10

Central
Monitoring
System

% Enable WG Port option [Enable Force Alarm]
via Parameter Setting of 701Server Software

% The Wiring of Enable "Share Door Relay" ( Set up via the parameterssetting Window of 701ServerSQL)

Connect to Electric Strike

12v s — o
: o
RN GND™Electric Strike
Main Port
+| POWER
—| 12VvDC
N.C.
com[ 3 f
4
PB
- N.O.
D) 8
\ WG Port ), GND
+| POWER
—| 12VDC

Tamper-Switch Alarm Wiring Method
(WG Port Door Sensor Wiring Method)

Controller

Main Port\

35‘ +| POWER

“Builti —
Tamper Switch _/ 12vDC

Buzzer
12VDC

% Enable [Share Door Relay] & WG Port option
[Enable Force Alarm] via Parameter Setting of
701Server Software

- 3B=



AR-837-E/EE/EF/ER/W

Relay" function.

837-E/EE/EF/ER WGoutput

% This wiring method is not eligible for "Share Door Relay" function (set up
via parameter setting of 701ServerSQL). If there is external wiring to Wiegand
reader, WG Port must enabled Digital Relay Output to enable "Share Door

AR-837-E/EE/EF/ER become WG mode

837-E/EE/EF/ER Master

RN

% The Wiring of Disable "Share Door Relay" ( Set up via the parameters

setting Window of 701ServerSQL

. When AR-837-E/EE/EF/ER become WG mode,it can be used with

any controllers.

WG1 Port Share Main Relay -> select 1: YES
Networking Setting: Select E Series Controller Parameter Edit in 701Server,
tick up the function “Ev5 WG out/Hv3 Lift out”

( ) 2. AR-837-EF support Anti-pass-back by finger or card.
BZ *Using Rule :
2| RLED Finger : Both AR-837-EF Master mode and AR-837-EF WG mode
W GLED must store all the same FP data and real or visual card number.
N Door Output
| weo Card : Can pass WG message to controller.
: WG 1 3. Standalone Setting: Enter programming mode -> 4. Parameters(2) ->
DS
 PB
S [}
L z < = W e Contter paramete
A A 12v_[+] POWER an e 1
GND |-] 12vDC | =m0 e

Open too long
100 long[WG)
AamRelay |1
Armed Delay
Am puse o

Duress Code

(] None English
[] Date Time Format(DD/MM)

Enable Push to Exit
Egress Baap Sounds
Enable Auto Relock

DOoRROO0 5
O0oOrREOOO

[ e zone 61
cose
/] EVS WG out/HV3 Lift out

[ Free RF Check at Finger Access

V220811
Strengthen security with AR-721RB Connect to Reader
Electric Bolt 12V —
12V 12V = +] POWER g
AR-1207 +] POWER GND = S
g GND GND | = - -| 12vDC -
< = =] 12vDC [P Exit E| Electric Bolt
.C.40 ————
:.g R N.C. BZ Main Port
R ‘[’I‘] N.O. ARLED Door Contact
Controller o B O CoM GLED Il
GNDHX) ’:0:4: CTL =My Door Output
™ Pe) ) £ 12v — WG 0 3
cvcoll N\ AR-721RB NG 1 4 e
3 WG-DS
—P—o0— Jwe-rPe
N.O. Y] ; BP9 W—
CN5
12v l—1<— I_ Bz NP WG Port  GND[Ej—T-0
EXIT GLEDM— Controller
—] 12V WG 0 M RTE
o B e sl —— 4|
[~ | RTE 12v_Ho- T—+| POWER
GND =1 12VDC

Free Zone

o

Duty shift

Menual

Rsds:

Ut Control Time (ec) [150
Body Temperature Wi ||
Area Code (None Poling) |0

5-1
@ uft Controller () Host Comm. Port
O LED Panel

Alarm Schedule

716E16/7218v2

O ne printer

Programming

e Lock/ Unlock

e Entering

o Exiting

C. Initial setup

e Language Setting

A. Keyboard Lock/ Unlock

Input * /123456 #| or * |PPPPPP #)
[e.g.] The Default Value= 123456. If already changed the Master Code= 876112, input |* 876112 #| — Access programming mode
P.S.If no instruction is entered within 30 sec., it will automatically leave the programming mode.

e Changing the Master Code
Access programming mode — 5 |Tools — 2|Master Code — Input the 6-digit new master code — Succeeded

* Node ID of Reader Setting
Access programming mode — 3 |Parameters[1] = 1)Node ID — Input New Node ID : 1~254 (default value:001) — Main Door Number : 0~255
— WG1 Door Number : 0~255 — Show UID (0=No, 1=WG, 2=ABA, 3=HEX) — Enable DHCP(0:No, 1:En, 2=Exit) — Succeeded

B. Entering and Exiting Programming Mode

Press * and #) simultaneously to lock keyboard. Press simultaneously again to unlock.

Press the *| *| repeatedly — 6 Quit or 7 Quit and Arming (Please refer to alarm / arming setting)

Access programming mode — 5]Tools = 1)Language — O0JEN — Succeeded — Initial system...

4 -



Power(Green
Alarm(Red
Arming(Green

LCD / Biometrics Access Controller
| LCD Card Energy Saver
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V220811

Function Description of Front Panel & Indicator

OK(Green)

1.

System will automatically exit Programming Mode when inactivating for 30
seconds.

LED status indicates controller's mode and status.

Left Overtime on
Right Overtime off|Return

Q= o (Red) OK (green) — blinking constantly when operating in Programming Mode
8 ) — or flashing an existed card in card learn mode, it comes 2 beeps
In processing(Green) warning and LCD panel displays “Same Card: user address / card
- number”
gleitance BhiviEipcions Error (red) — invalid card with 2 beeps warning and LCD panel displays “Card
— Number Err!”
Press"! time” | Press'2 times — or in anti-pass-back mode, when violates the access, it comes one
(F)Up Dutyon [Break out beep warning and LCD panel displays “Anti-pass Error!”
(17 DownDuty off  |Break RTN Arming (green) — arming on status

Go

@ Esc/Quit (#) Enter / OK

Alarm (red) — any abnormal condition occurs

3.  Keypad will be locked up 30 sec. when incorrect pin code or master code is
constantly entered.

4. Maximum error input of pin code and master code can be changed via the
software 701Server (default: 5 times)

Networking :/and # interactively flash between the Month and DAY.

[e.g.] 12/07——12/07
Stand-alone : No flashing [e.g.] 12/07

(«Reference to picture)

Manu Tree

% The full screen menu setting is on page10 - Full Function Command Menu Table

1. Add/ Delete
1.Add > Card ID

2. Add > RF Learn

3. Suspend > Address

4. Suspend > ID #

5. Delete > Address

6. Delete > ID #

7. Recover > Address|

8. Recover > ID #
' 9. Antipass Group

2. User Setting 3. Parameters[1] | 4. Parameters[2] | 55. Tools 0. UART Port CN9

1. Password 1. Node ID 1. Auto Relock 1. Language A. Event Logs |
2. Access Mode 2. OnOff OpenZone 2. Egress(R.T.E) 2. Master Code
3. Extend Options 3. Door Relay Tm 3. Miscellaneous 3. Master Range 6. Quit |
4. Single Floor 4. Door Close Tm 4. Force Open 4. Terminal RS-485
5. Multi Floor 5. Alarm Relay Tm 5. Close & Stop 5. Ext.Comm CN11 7.5uit & Arming
6. Enroll Finger 6. Alarm Delay Tm 6. Anti-pass-back 6. Open Time Zone
7. Delete Finger 7. Arming Delay Tm 7. Duress Code 7. Informations

8. Arming PWD 8. Password Mode 8. Clock Setting

9. Factory Reset 9. Daily Alarm

D. Adding and Deleting Tag

X User capacity: 16384 (00000~16383)

Tag Informatlon

mww 8195
nnnmz sizey—CARD CODE
SITE CODE

CARD CODE
SITE CODE

e Adding Tag by Tag ID

Access programming mode — 1)Add/Delete — 1JAdd -> Card ID — Input 5-digit user address — Input Site Code — Input Card Code

e Adding Tag by RF

Access programming mode — 1)Add/Delete — 2)Add -> RF-Learn — Input 5-digit user address

Learn Function

— Input Tag Units(pcs) — Close Tag into RF Area
XIf the batch of tags are Sequential, input Tag Units(pcs) in the quantity of the tags and present the tag with

the lowest number to the controller for adding all the tag data; otherwise, the tags must be presented to the controller individually

o Suspend User Address
Access programming mode — 1 |Add/Delete — 3)Suspend -> Addr — Input Start address — Input End address

» Suspend Tag by Tag ID
Access programming mode — 1JAdd/Delete — 4 |Suspend -> ID # — Input Site Code — Input Card Code

o Recover User Address
Access programming mode — 1JAdd/Delete — 7 |Delete -> Addr — Input Start address — Input End address

* Recover Tag by Ta

glD

Access programming mode — 1]Add/Delete — 8 |Delete -> ID # — Input Site Code — Input Card Code

o Deleting User Add

ress

Access programming mode — 1)Add/Delete — 5 |Delete -> Addr — Input Start address — Input End address

-5-



AR-837-E/EE/EF/ER/W

V220811

o Deleting Tag by Tag ID

Access programming mode — 1JAdd/Delete — 6 |Delete -> ID # — Input Site Code — Input Card Code

o Setting up the access mode

Access programming mode — 2 JUser Setting — 2JAccess Mode — Input User Address — 0: Invalid; 1: Card ; 2: Card or PIN; 3: Card & PIN

E. PIN Code

Access programming mode — 2 ]User Setting — 1 |Password — Input 5-digit user address — Input 4-digit PIN (0001~9999) — Succeeded

Or via 701Client set it on Users screen
F. Adding / Deleting Fingerprint
e Adding

Access programming mode — 2 |User Setting — 6] Enroll FP — Key in 5-digit user address —1 or 2 different fingers on the sensor lens — Succeeded
P.S. The AR-837EF(9000DO) needs to collect twice for each fingerprint ; however, AR-837EF(1500D0O) needs to collect three times for each fingerprint.

o Deleting

Access programming mode — 2] User Setting — 7 | Delete FP — Key in 5-digit user address — Succeeded

P.S. If you want to delete all users’ FP, key in 99999 #|

G. Access Mode

Access programming mode — 2 |User Setting

— 2] Access Mode

— Key in 5-digit user address (00000~08999)

— 0: Invalid; 1:Card; 2: Card or PIN; 3: Card and PIN
(837EF: — Finger Identify: 0: Must ; 1: Ignore )

— Succeeded

H. Arming Password

Access Mode

Finger Identify (837EF Only)

Result (837EF Only)

Hardware | 701Client

Hardware

701Client

[[] Just fingerprint

: Must
O:Invalid L] Just c.ard corjtrol Invalid User
e Just fingerprint
9 Just card control
: Must [ Just fingerprint Finger+Card
1:Card [] Just card control
’ . lanore Just fingerprint 1. Card Only
19 M Just card control 2. Finger Only
1. Finger+Card
2. Finger+PIN
- Must [[] Just fingerprint 3. Card+Finger+PIN
’ [] Just card control 4. Card+Finger+Card
2:Card or PIN 5. PIN+Finger+PIN
6. PIN+Finger+Card
. Just fingerprint 1. Card Only
+lgnore Just card control 2. PIN Only
3. Finger Only
. Must [7] Just fingerprint Finger+Card+PIN
s:Card and PIN [] Just card control
sardan . lanore M Just fingerprint 1. Card+PIN
19 M Just card control 2. Finger+PIN

Access programming mode — 3 Parameters[1] — 8] Arming PWD — Input 4-digit PIN (0001~9999; Default: 1234) — Succeeded

Or via 701Server and set it on AR-829E screen
I. Arming Delay Time

Access programming mode — 3J Parameters[1] = 7JArmingDelayTm — Enter armed sta. Delay time(Sec), Range:000~255 ;
Armed pulse out-put time (10ms) ,Range : 000~255 — Succeeded

J. Duress Code

Access programming mode — 4 |Parameters[2] — 7 |Duress Code — 4 sets (select one) — Input 4-digit PIN (0001~9999) — Succeeded

Or via 701Server to set it on AR-829E-V5 screen

XDuress Code is only available in networking mode. It will substitute a personal pin code and send the message of Duress to computer as a warning signal.

X The Duress Code 0000 means that disable Duress Function and the default value is set as 0000 already.

K. Terminal Port

Access programming mode — 5)Tools — 4] Terminal Port — 0:Lift ; 1:Host ; 2:LED ; 3:PRN (default value:1) — Baud Selection

(default value:9600) — Succeeded
L. Setting up the alarm / arming
e Conditions:

1. Arming enabled

2.Alarm system connected
o Situations:

1. Door is open overtime: Door is open longer than door relay time plus door close time.
2. Force open (Opened without a valid user card): Access by force or illegal procedure.
3. Door position is abnormal: Happening when power is off and then on again, besides, reader was on arming before power went off.




* Enable/Disable the arming status:

Standby Mode

Card only Card or PIN Card and PIN

Open the door
Present the tag to reader — Input
4-digit arming PWD — #]

No open the door
*|— Input 4-digit arming PWD
— Present the tag to reader

Input user address — Input
4-digit individual PWD — #| —
Input 4-digit arming PWD — #)

Present the tag to reader — Input
4-digit individual PWD — #—
Input 4-digit arming PWD — #)

Access Programming mode

Enable: Access programming mode — 7 Quit & Arming Disable: Access programming mode — 6 JQuit

% [Use FP] can substitute for [Induct valid card].

M. Anti-pass-back

While connecting with AR-721-U, AR-737-H/U(WG mode) and AR-661-U for anti-pass-back function, the access mode must be "Card" only.
e Device enable

Access programming mode — 4 Parameters[2] — 6 Anti-pass-back — master controller select [1: Yes] = WG select [1: Yes]
e Card user enable

Access programming mode — 1)Add/ Delete — 9 )Antipass Group — Input 5-digit starting user address — Input 5-digit ending user
address — must select [1: Yes]

N. Lift control
[e.g.] Connect with AR-401R0O16B to control which floor the user will be able to access. (BAUD9600)
o Setting Lift control

Access programming mode — 5)Tools — 4] Terminal Port = 0: Lift Controller — Baud Selection 0: 9600

Access programming mode — 5 /Tools — 5 Terminal Port — 1: Lift Controller
(need to use 725L485)

Set Floor/ Sto

5|6 10 11 15 16
0,0 0|0/ 0 O O 0 0 0/0/ 0/ 0 O

18 2122 5|26 |27 31(32
2,0/0 0 0/0/ 0O 0/O0|0 O|O/O0O/0O0|0 00O
37 38 42 43 6 47 48
3 0 0 0, 0 0 0 0
545 1 62 63 64
4 0 0 0 00 0

s Single floor

Access programming mode — 2 User Setting — 4 )Single Floor —

Input 5-digit user address — Input single floor number: 1~64

o Multi floors

Access programming mode — 2 |User Setting — 5 |Multi Floor — Input 5-digit user address — Select range: 1 or 2 or 3 or 4 — Input 16 digits

multi floors number [0:disable, 1

: enable]

[e.g.] Set NO. 114, can use it through the 8 F and 16F:
Access programming mode — 2]User Setting — 5 Multi Floor — 114 #) — 1 #) — 0000000100000001 # )

0. Alarm Clock (for Factory)

Access programming mode — 5)Tools — 9] Daily Alarm — Set (00~15) — Set Start Tm (24 Hours) ; Set Effect Sec.
(Seconds as the bell time, Range:1~255) — Set Weekday (0:disable, 1: enable) — Succeeded

e Hardware installation

POWER E o
12vDC [-]
DC 12V Relay Board P ﬂ]_\
1]
2]
3]
3
""""""""""""""""""" Mike device|=::73
: Music Box : " (6] |ALM
1 Horn H H —L 12V
E @)—q;{\_ Board E oD 8| |GND
E : 117 Mike's sound wire | Music Box | Controller )
Vike device =222 Output to M1 and M2
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ACCESS & INDUSTRIAL CONTROL

P. OpenZone

Access programming mode — 3| Parameters[1] — 2)OnOff OpenZone — Main Controller Auto Open Zone (0:disable, 1:enable) —
Open Door Imm. During Open Zone (0:No, 1:Yes) — WG1 Port Auto Open Zone (0:disable, 1:enable) =~ Open Door Imm. During
Open Zone (0:No, 1:Yes) — Succeeded

Q. Open TimeZone

Access programming mode — 5)Tools — 6)Open TimeZone — Set (00~15) — Time (24 Hours) ; Main Port (0:disable, 1: enable) ;
WG Port (0:disable, 1: enable) =~ Weekday (0:disable, 1: enable) — succeeded

Firmware Upgrade

Get the upgrade software from SOYAL or our distributor and run “UdpUpdater” software

o104
1
o Execute the software = The software is within SOYAL CD or please login the SOYAL website to download
LR TS
B Controller update tool (Ver2.02) 2
Firmware [\\Snya\—fset\.sp\Amz.r,Evz,ﬁmEvs,szaEvs,smE\AREEWE\ |nsz?? | Loadrmwv I Update FAv |
LCOFont  fySoyelfs#ispLoD Fonts\BSLEDFONTLF1 [ | oad Font ][ Update Font ]
I are |D'\LCD Imageld21 EFvE-120405-T3 bmp [ e ” Update Image ]
pdate Path
@ Ethemet TargstlP 192.168.1.127 part 1604 | pode |1
OSersl (COM)  TargetMode |1 COM1
SelectPevice o
O ARp27Iv2 | GFM3 / 725EB | e EcrE
O APNe7iv3 r [
|© AR725EVe/ARBET EARER] EvE/ARDZIEVS| ]
iy Recent
Dacuments
Desktop
;E 6”
& My O ocuments
? S tdp Camputer
CONTROLLER(182.168.001.127 ! N
g File name: |4PEBRIELS_ ¥OR0ZSTH - deen |
Default boot loader address is 192.168.1.128 (1604) My Natwark Files of type: |mem Fillsi ¥ uif * stm) LI Cancel
Places [~ Open as read-only |
:.

o Update the firmware
[Please login the SOYAL website to download the new ISP Firmware.]
1. Input the Target Address and Port
2. [Load F/W] open the documents that have the new ISP Firmware
3. Click the new ISP Firmware and [Open] it
4. Click [Update F/W] to start the firmware update
5. Till the screen shown [Firmware Update is Complete]

Restoring Factory Settings
Reset all device parameters and user card data

o Reset all device parameters and user card data:
Access programming mode — 4 | Parameters2 — 9 Factory Reset —~0 : System Param ;
1 : User Setting ; 2 : System & User
® Reset IP Setting:
When the device's power is on, press the [RESET] button on the main board untill the ERR (Red)
LED of screen lights up. (Refere to the picture beside)

i and then reset the power of the controller. The device will be restored to factory settings.
1% After having done the "Factory Reset," the External Communication Port must be reset. Or
the biometric sensor won't be functional.

5|Tools — 5| Ext. Comm Port (0:FP-200 ; 1:Lift ; 2:Vein2000 ; 3:FP-9000 ; 4:Reserved )




* Open your Web Browser and input factory default IP
address: http://192.168.1.127

G0+ [o - mwm |

¥ (8] (%][x] [F5ae J(oF)

BRO GHE HAO MORFW IR0 BH®
s nn | o 0

s - ) BT )RR Homal ) AR S -
@ Contooller ]

[ x &-

& - O @ - #EO- ¥REQ- IRO- @- 7

If the IP address of AR-837 (E/EE/ER/

Access Control System

* Page menu

Current Status | <€

Network Setting | €———————1IP Setting

<—  Change the Log-in information

Monitor the on-line computer

o Current State

Online Status is able to monitor and
show which computer is linking on Ethernet Module

Show which computer is linking
on Ethernet Module.

G- o) mimim

Ver1.09

EF) has be changed, we must enter the ACCESS CONTROLLER
new |P address. 0 CurrentIP Addresses

Current State Remote IP. (Port) State

192.168.001.021(0080) CONNECTED
Network Setting [Name [Type IP address ‘Subnet mask |Gateway |DHCP |
User Password ett [Ethemet (1601127 B ] e | |
ET3 © mra Ga- mu0% -

. deExE== T |

WRO ®EE ®BRO HZOREQW IRD NEQ
Yo BORE | o [lennms - ) BEBEE E) R Homel B MEHTEE -

]

x

|§|

Current IP address

¢ Log-in User Password
When you choose the "Networking Setting" or "User Password"
Log-in window will pop out and please input
X At the Factory Default
User name: SuperAdm
Password: 721568

* Networking Setting

You will find initial IP Address 192.168.1.127 and check
MAC Address is identical to the sticker on Ethernet Module
device. Please alter the IP address as you want, and then
click “Update” button. After updating the IP, please re-
connect the Web Browser by the new IP address.

e User Password

Change the log-in password to lock the IP setting of
Ethernet Module.

The password is composed of 10 characters at most which
can be either A~Z or 0~9.

@ Contoller & - e #RQ- TRHQ- TRO- @- 7
Access Control System Ver109 SOYAL
Recess conTrotieR
e Current IP Addresses
Curent Staie Remote IP Por) State
92 168 0771 02110080) CONNECTED
Network Setting Name Typ: IP address |Subnet mask |Gateway [DHCP |
User Password et e | | EEmn ] [ I |
£ N © mna Va- R100% -
: i x
Authentication Required
httpi//192.168.1.127 requires a username and password,
Your connection to this site is not private.
at first.

Password: | 721568

[ [ e

lx - Windows Intornet Explorer.
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Access Control System Ver109
Recess contRoLLER
Network Setting
Current State

Network Setting

After you have changed the IP address, the device will restart (hardware reset).
You need to change the host IP with new IP Address in Internet Browser to re-connect the target.

User Password o S
Device Name
LANIP Address TGL1681127
LAN Net Mask [2ss 2452550
Default Gateway [rozgerzse ]
Primary DNS Server [
Secondary DNS Server [CE e
MAC Address S |
DHCP Client 8]
TCP Listen Port 121 % 024-0999)

=
E

/= Controllex - Windows Internet Explorer
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User Password Setup
Current State New Password

Network Setting Password Again

User Password
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Full Function Command Menu Table

o Entering

1. Add/ Delete
1-1. Add -> Card ID

Input *]123456 #| or *|PPPPPP #)
[e.g.] The Default Value= 123456. If already changed the Master Code= 876112, input * 876112 #

— Access programming mode
P.S.If no instruction is entered within 30 sec., it will automatically leave the programming mode.

1-2. Add -> RF-learn

1-3. Suspend -> Address

Esc/Quit

1-4. Suspend > ID #

1-5. Delete > Address

Range: (0-65535)

1-9. Antipass Group

1-1-1 1-2-1 1-3-1 1-4-1 1-5-1
User Address: User Address: Input Start Address Set  Site: Input Start Address
00000 XXXXX F3: Prev F4: Next Range: (0-16383) 00000:XXXXX Range: (0-16383)
Range: (0-16383) Range: (0-016383) Range: (0-65535)

1-1-2 v 1-2-2 v 1-3-2 v 1-4-2 v 1-5-2 v
Set (User Address) Code: Tag Uints (Pcs) Input End Address Set  Code: Input End Address
00000 XXXXX Must be Sequence Range: (0-16383) 00000:XXXXX Range: (0-16383)
(1-10 Digital) Range: (1-016378) Range: (0-65535)

1-1-3 ‘l' 1-2-3 ‘l’
Set (User Address) Code: Close Tag
00000:_XXXX Into RF Area

F3: PreV F4: Next
Range (0-016383)

F3: Prev F4: Next
Range (0-163833)

F3: Prev F4: Next
Range (0-16383)

F3: Prev F4: Next
Range: (0-016383)

1-6. Delete > ID # 1-7. Recover > Address 1-8. Recover > ID # ‘1’
1-6-1 1-7-1 1-8-1 1-9-1 1-9-3
Set  Site: Input Start Address Set  Site: Input Start Address Enable Antipass
00000:XXXXX Range: (0-16383) 00000:XXXXX Range: (0-16383) 0:NO 1: YES
Range: (0-65535) Range: (0-65535) Data: 0
1-6-2 ¥ 174 v 1-8-2 v 1-9-2 v
Set Code: Input End Address Set Code: Input End Address
00000:XXXXX Range: (0-16383) 00000:XXXXX Range: (0-16383)
Range: (0-65535) Range: (0-65535)
2-1. Password 2-2. Access Mode 2-3. Extend Options 2-5. Multi Floors 2-6. Enroll Finger (837EF)
2-1-1 2-2-1 2-3-1 2-5-1 2-6-1 (837EF)
User Address: User Address: User Address: User Address: User Address:

F3: Prev F4: Next
Range: (0-016383)

2-1-2 ¥ 2-2-2 ¥
Input PIN Code 0: Invalid 1: Card
Rang: 0000~9999 2: Card or PIN
3: Card & Pin

2-2-3 (837EF) ¥

Finger / Face
0: Must 1: Ignore
000000=0

032 V¥

Is Guard User
0: NO 1: YES

233 ¥

Enable Antipass
0:NO 1:YES
Data: 1

4. Single Floor
2-4-1

User Address:
F3: Prev F4: Next
Range (0-016383)

242 V¥

Set Single Floor
(Range: 01~64)
Clear the Others

252 W

2-6-2 (837EF) ¥

Select Range:
1:01-16 2: 17-32
3:33-48 4:49-64

Enroll Fingers ?
Range: (1-2)
1

2-5-3 v 2-6-3 (837EF) v
0->NO 1->YES Put 1st Finger Center
Current Setting: Image Pls
1000000000000000 Scan Data ...

2-7. Delete Finger (837EF)

2-7-1 (837EF)

Enter/OK

User Address:

F3: Prev F4: Next
Range: (0-099999)
000000




Full Function Command Menu Table
3. Parameters [1]

3-1. Node ID 3-2. OnOff OpenZone
311 313 ¥ 315 ¥ 317 ¥ 3-2-1
Input New NodelD WG1 Door Number Enable DHCP Net Mask (IPv4) Main Controller

192 . XXX.XXX.XXX

Range: 001~254 Range: 000~255 0:No 1:En 2: Exit 255.255.255.000 Auto Open Zone
Current Data: 001 192.168.001.127* 255.XXX.XXX. XXX Dis/Enable (0/1)
0 0
3-1-2 v 3-1-4 v 3-1-6 v 3-1-8 v 3-2-2 v
Main Door Number Show WG Message IP Address (IPv4) Gateway (IPv4) WG1 Port Auto Open
Range: 000~255 0: NO 1:Enable 192.168.001.127 192.168.001.254 Zone Dis/Enable (0/1)

192 XXX.XXX. XXX

3-3. Door Relay Tm
3-3-1

3-

4. Door Close Tm
3-4-1

3-5-1

3-6. Alarm Delay Tm
3-6-1

3-5. Alarm Relay Tm

3-7. Arming Delay Tm
3-7-1

Main Door OpenTm
Range: 000~609
601~609=0.1~0.9
0077

Main Door Close
delay time (Sec)
Range: 000~255
015

Alarm Relay Time
Range: 000~609

601~609=0.1~0.9
015

Alarm Output
Delay time (Sec)
Range: 000~255

Enter armed sta.
Delay time (Sec)
Range: 000~255
001

3-3-2 ‘l'

3-4-2 \l'

WG1 Door OpenTm
Range: 000~609
601~609=0.1~0.9

WG1 Door Close
delay time (Sec)
Range: 000~255

3-7-2 J’

Armed Pulse out-
put time. (10ms)
Range:000~255

007 015 000
8. Arming PWD. 3-9. PIN&UID format
3-8-1 3-9-1 3-9-3 3-9-5 3-9-7
Input PIN Code User PIN Length Show UID :0=No RFID 125KHz RF User Capacity:
Range: 0000~9999 Range: 4~8 1=WG 2=ABA 0: Disable 0: 16384 1: 32768
1234 4 3=HEX 4=WG26 1: Enable 2:65536 (0~2)
5=ABA8 1 0
1
392 ¥ 394 ¥ 396 WV 398 WV
Card UID Length NFC 13.56MHz RF '#'is Door Bell Enable Buzzer
Range: 2~8 0: Disable 0: Disable 0: NO 1:YES
4 1: Enable 1: Enable 1
1 0
4. Parameters [2]
4-1. Auto Relock 4-2. Egress(R.T.E) 4-3. Miscellaneous
4-1-1 4-2-1 4-3-1 434 ¥ 437 ¥
Main Controller Main Controller Main Controller WGH1 Port WG1 Port
Auto Relock Door Request TO Exit TimeAttendance Skip PIN Check Share Main Relay
0: NO 1:YES 0: Dis 1:Enable 0: YES 1:NO 0:NO 1:YES 0: NO 1:YES
0 0 0 0 0
4-1-2 v 4-2-2 v 4-3-2 v 4-3-5 v 4-3-8 v
WG Prot WG1 Port WG1 Port Main Controller Tag Second time
Auto Relock Door Request TO Exit TimeAttendance Pass any Tags interval (10ms)
0: NO 1:YES 0: Dis 1:Enable 0: YES 1:NO 0: NO 1: YES Range: 0000~9999
0 0 0 0 0100
4-3-3 v 4-3-6 v 4-3-9 v
Main Controller WGH1 Port Max error times
Skip PIN Check Pass any Tags for lock keypad
0: NO 1: YES 0: NO 1: YES Range: (0~9)
0 0 5




Full Function Command Menu Table
4. Parameters [2]

4-3. Miscellaneous

4-4. Force Open ..

4-5. Close & Stop

4-6. Anti-passback

4310 b 4312 Y 4-4-1 4-5-1 4-6-1
Main Controller Lock Door Relay Main Controller Main Controller Main Controller
On Egress Beeps 0: NO 1: YES Force Open Alarm Close Door Stop Anti-passback
0: NO 1:Bi 2:Bibb 0 0:NO 1:YES Alarm 0: NO 1:YES 0: NO 1:YES
2 0 0 0

4-3-11 v 4-3-13 (8376F) W 4-4-2 v 4-5-2 v 4-6-2 v
WG1 Port Main Controller WGH1 Port WGH1 Port WG1 Port
On Egress Beeps Free Tag Always Force Open Alarm Close Door Stop Anti-passback
0: NO 1:Bi 2:Bibb O:NI' 1:YES 0:NO 1:YES Alarm 0: NO 1:YES 0: NO 1:YES
2 0 0 0 0

4-7. Duress Code
4-7-1

4-8. Password Mode
4-8-1

4-9. Factory Reset
4-9-1

Input PIN Code
Range: 0000~9999

Password Mode
0: Addr. & PIN(M4)
1: PIN(M8) 2:M6
1

0: System Param.
1: User Setting

2: System & User
2

5. Tools

5-1. Language

5-3. Master Range

5-4. Terminal RS-485

5-5. Ext.Comm CN11

|
553 ¥

5

5-1-1 5-3-1 5-4-1 5-5-1
0: English (USA) Input Start Addr 0: Lift 1: Host 0: Suspend  1:Lift Elevator floor
1: Chinese (TW) Range: (0-16383) 2:LED 3: PRN 2: Voice 3: PRN button available
0 000000 1 1 Range: (1~600)
000
2. Master Code 5-3-2 v 5-4-2 v 5-5-2 v
SI:p1ut MasterCode Input End Addr Bud Selection 0: 4800 1:9600
000001-999999 Range: (0-16383) 0: 9600 1: 19200 2: 19200 3: 38400
000000 2:38400 3:57600 1
123456

5-5. Ext.Comm CN11
(837EF)
5-5-1 (837EF)

0: FP-Type 1: Lift
2: Vein2000 3:

3

5-6. Open Time Zone

5-7. Informations

5-9. Daily Alarm

5-0. UART Port CN9

5-6-1 5-7-1 5-9-1 5-0-1
Set <F1~F4,#>: 01 F/w Ver: 4.4T Set <F1~F4,#>: 01 0: Lift9600 1: PRN
00:00~00:00 .. Users: 00000 00:00 Sec.=000 2:LED  3: Voice
SuMoTuWeThFrSaHo Messages: 00000 SuMoTuWeThFrSaHo 0
00000000 Press any Key ... 00000000

5-6-2 v 5-9-2 v 5-0-2 v

Time=00:00~00:00
Nain Port (0/1):0
WG Port (0/1):0

5-6-3 v

Weekday: (0/1)
SuMoTuWeThFrSaHo
XXXXXXXX
00000000

5-8. Clock Setting
5-8-1

YY: XXXX MM: XX
Day: XX  Hour: XX
Min: XX Sec: XX

5-8-2 \l'

Month/Day Format
0: DD/MM  1: MM/
DD

Start Tm=00:00
Effect Sec.=000

Elevator floor
button available
Range: (1~600)
015

5-9-3 v

Weekday: (0/1)
SuMoTuWeThFrSaHo
XXX XXXXX
00000000

5-A. Event Logs
5-A-1

20'06/04 2359:26

(M24)Controller
Power On 00000

»* More Details : Introduction of New Function Commands for Enterprise E Controller and Home H Controller

6. Quit

7. Quit & Arming
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